
General Ledger Year-End Processing Guidelines 

INTRODUCTION 
Read this document before you perform any steps. If you have any questions, contact Microsoft 
Business Solutions Technical Support. 
 
During the year-end closing routine, all the records that will be moved are put in a temporary table 
before they are moved to the GL30000 table. You must have free disk space that is equal to the size 
of the GL20000 table to perform the routine. 
An Automated Solution script may be available to perform this task. For more information about the 
year-end close Automated Solution, visit the following Microsoft Business Solutions Web site:  
https://mbs.microsoft.com/customersource/support/AutomatedSolutions.htm 

MORE INFORMATION 

1. Complete the posting procedures and the closing procedures for other modules. 
 
Only perform this step if the General Ledger module is integrated with other modules. If 
the General Ledger module is not integrated with other modules, skip this step.  

a.  Post final transactions in all the modules except the General Ledger module. 

b.  Complete the month-end procedure and the quarter-end procedure for all the 
modules except the General Ledger module.  

c.  Complete the year-end closing procedures for each module in the following order:  

1. Inventory 
 
For additional information, click the following article number to view the 
article in the Microsoft Knowledge Base:  
872713 Inventory year end closing procedures - 2004  

2. Receivables Management 
 
For additional information, click the following article number to view the 
article in the Microsoft Knowledge Base:  
857444 Tips for performing the Receivables Management year end close 
in release 7.x and 8.0  

3. Payables Management 
 
For additional information, click the following article number to view the 
article in the Microsoft Knowledge Base:  
875169 Payables Management year end closing procedures  

4. Fixed Asset Management 
 
For additional information, click the following article number to view the 
article in the Microsoft Knowledge Base:  
865653 What are the recommended Fixed Assets year end procedures  

 

Note Year-end procedures for the Payroll module are independent of the procedures in 
other modules. These procedures are always performed at the end of the calendar year. 
For additional information, click the following article number to view the article in the 
Microsoft Knowledge Base:  

850663 Payroll year-end closing checklist for 2004  

2. Post the final adjusting entries in the General Ledger module. 
 
Adjusting entries include all entries that correct errors that were made when transactions 



were recorded. Adjusting entries also include journal entries that are used to assign 
revenues or expenses to the period that the revenues were earned in or that the expenses 
were incurred in. 
 
If you must make any adjusting entries to allocate revenue, expenses, or depreciation to 
the year that you are closing, use the Transaction Entry window or the Quick Journal Entry 
window to make adjusting entries in the General Ledger module. 
 
The Second Closing Period feature in the General Ledger module lets you have a second 
closing period that has the same start date as the last day of the first closing period. This 
feature lets you add initial adjusting entries in the first closing period and post-audit 
entries in the second closing period. This enables separate tracking of the adjusting 
entries that are made after the year is closed. 
For additional information about second closing periods, click the following article number 
to view the article in the Microsoft Knowledge Base:  

871679 Second closing period  
Note If you are using closing periods and you reconcile, your transactions all move to the 
first period with the start date.  

3. 
Print an account list to verify the posting type of each account. 
 
The posting type determines whether an account is closed to the retained earnings 
account or whether an account brings a balance forward to the next fiscal year. If the 
account balance is going to be brought forward at the end of the year, the posting type 
must be set to Balance Sheet. If the account balance is going to be closed to a retained 
earnings account at the end of the year, the posting type must be set to Profit and Loss. 
Use the Account Maintenance window if you must change the posting type for an account.  
 
Follow these steps to print an account list:  

a.  Click Reports, click Financial, and then click Accounts. 

b.  Select All Accounts in the Reports list, and then click New. 

c.  Type all accounts in the Option field. 

d.  If you are using Great Plains 8.0 or a later version, click to select the Inactive 
Accounts check box. 
 
Note In Great Plains 8.0, you can deactivate accounts that have a balance. These 
accounts are still processed during the year-end closing routine according to their 
posting type. 

e.  Click Destination to specify a report destination, and then click OK. 

f.  Click Print. 
 

4. Close the last period of the fiscal year. 
 
This step is optional. 
 
You can use the Fiscal Periods Setup window to close any fiscal periods that are still open 
for the year. This prevents transactions from being posted to the wrong period or year. 
 
Notes  

• Make sure that you post all the transactions for the period and the year for all 
modules before you close the fiscal periods. Later, if you have to post transactions 
to a fiscal period that you already closed, you must return to the Fiscal Periods 
Setup window to reopen the period. 

• If you use FRx Reporter, keep one period in the most recent historical year open to 



prevent the following error message:  
FRX Print Engine Failed to Load the Company Calendar. 
For additional information, click the following article number to view the article in 
the Microsoft Knowledge Base:  
874932 "Failed to load company calendar" checklist for FRx  

 

5. Perform file maintenance on the Financial series group of modules. 
 
Perform the shrink procedure, the rebuild procedure, and then run the check links 
program on the Financial series group of modules. 
 
Note If your Great Plains installation uses Microsoft SQL Server, you only have to run the 
check links program. 

6. 
Verify the settings in the General Ledger Setup window. 
 
If you want to keep historical records, you must click to select the Accounts check box 
and the Transactions check box in the Maintain History area of the General Ledger 
Setup window. The account history lets you print financial statements and calculated 
budgets from historical information. The transaction history lets you print detailed 
historical trial balances and lets you view transaction detail. Both the account history and 
the transaction history are updated during the year-end closing routine if these check 
boxes are selected. 

7. Make a backup. 
 
Make a backup of all company data, and put the data in safe permanent storage. The 
backup gives you a permanent record of the company's financial position at the end of the 
year. The backup can then be restored later if it is required.  

8. Print a final Detailed Trial Balance. 
 
Use the Trial Balance Report window to print a year-end Detailed Trial Balance.  
 
Note We recommend that you post all transactions for the period and the year for all 
modules before you print the Detailed Trial Balance. If you post additional transactions 
later, we recommend that you print a new Detailed Trial Balance.  

9. Print year-end financial statements.  
 
Print any year-end financial statements that are required. The most common financial 
statements include the following:  

• Balance Sheet 

• Profit and Loss Statement  

• Statement of Cash Flows 

• Statement of Retained Earnings 
 

10. Set up a new fiscal year. 
 
Before you can perform the year-end closing routine, you must set up a new fiscal year by 



using the Fiscal Periods Setup window. 

11. Close the fiscal year.  
 
To close the fiscal year, follow these steps:  

a.  Click Tools, click Routines, click Financial, and then click Year-End Closing. 

b.  Specify an account in the Retained Earnings Account field. 
 
The account that you specify in the Retained Earnings Account field is the 
account that the year's profit or loss is closed to. The default account is the 
account that you specified in the General Ledger Setup window.  
 
All current-year earnings or losses are transferred to the account that you specify 
here. If you want to distribute the retained earnings for the year to more than one 
account, you can specify an allocation account to distribute the retained earnings 
amount to the appropriate accounts. For example, you could set up an allocation 
account to divide the earnings between several departments in your business. 
 
Or, you could transfer the year's profit or loss to accounts that contain a specific 
account segment. This is referred to as closing to a divisional retained earnings 
account. For additional information, click the following article number to view the 
article in the Microsoft Knowledge Base:  
850615 How to use divisional retained earnings accounts in General Ledger  
See the "Frequently-asked questions" section for additional information about how 
to close to divisional retained earnings accounts. 

c.  Specify the number that you want to use as the first journal entry number for the 
next fiscal year in the Starting Journal Entry field. 
 
You can accept the default number. The default number is one more than the 
highest journal entry number that is posted for the current year. Or, you can 
specify a new number. The journal entry number that you specify is used as the 
journal entry number for the Year-End Closing Report. 

d.  Click Close Year to start the routine. 
 
Important Click Close Year one time. If you click more than one time, you will 
close more than one year during the process. Also, if the progress window appears 
to stop at 50 percent, do not restart the routine. As long as the hard disk is 
processing, let the process continue. 

If you are maintaining account history, the year-end closing routine transfers all current-
year information for each account in the chart of accounts to account history. If you are 
maintaining transaction history, the year-end closing routine also transfers all current-
year information for each account in the chart of accounts to transaction history. The 
process then prepares the accounting system for a new fiscal year. Besides transferring 
current-year figures to transaction history and to account history, the year-end closing 
routine does the following:  

• The year-end closing routine reconciles and summarizes the general ledger 
balances that accumulated throughout the year. 

• The year-end closing routine removes accounts that are marked as inactive if the 
accounts match the criteria for deleting a posting account. Inactive accounts that 
have been set up as budget accounts can also be deleted if they have no activity 
for the year. These accounts can be deleted even if they have budget amounts 
associated with them from past years.  

• The year-end closing routine moves all profit and loss account balances to the 
retained earnings account. 



• The year-end closing routine summarizes balance sheet accounts and brings the 
balances forward as the beginning balances of the account in the new fiscal year. 

• The year-end closing routine prints the Year-End Closing Report. 

When the year-end closing routine is complete, the Year-End Closing Report is printed. 
This report lists the accounts that were closed and the transactions that were created to 
close those accounts. The Year-End Closing Report is part of the audit trail. Save this 
report for your company's permanent records. The Year-End Closing Report cannot be 
reprinted. 
 
Note After you close the year, we recommend that you perform the shrink procedure on 
your financial data files to free disk space. Do not perform the shrink procedure or the 
rebuild procedure if you use Microsoft SQL Server. If you use Microsoft SQL Server and if 
database maintenance is not automated, we recommend that you perform database 
maintenance. 
 
For additional information about recommended database maintenance procedures, click 
the following article number to view the article in the Microsoft Knowledge Base:  

866439 Recommended SQL database maintenance for Great Plains  

12. 
Close all fiscal periods for all series. 
 
This step is optional. 
 
After you complete closing procedures for all modules, use the Fiscal Periods Setup 
window to mark all periods for all series as closed. We recommend that you do this to 
prevent transactions from being posted from any module to any period that you closed. 
After a period is marked as closed, transactions cannot be posted to the period unless you 
reopen the period. Later, if you must post a transaction to a closed period, return to the 
Fiscal Periods Setup window to reopen the period. 

13. Adjust budget figures for the new year and print financial statements. 
 
Adjust budget figures by using one of the following windows:  

• Excel-Based Budgeting 

• Budget Maintenance 

• Single-Account Budget Maintenance 

Print the Profit and Loss Statement to verify that profit and loss accounts were closed to 
the retained earnings account. Print the Balance Sheet to verify that balance sheet 
accounts indicate that the balances were brought forward. 
 
If you are using Advanced Financial Analysis to print your financial statements, you must 
update the report layout to reflect the current fiscal year. To do this, follow these steps:  

a.  Click Reports, click Financial, and then click Advanced Financial. 

b.  Select the financial statement from the Reports list, click Open, and then click 
Layout. 

c.  Double-click the first column heading. 

d.  If the column type is set to Period Range, Year-to-Date, or Variable Year-to-
Date, select the current fiscal year in the Year list, and then click OK. 

e.  Repeat steps a through d for each column of each report. 
 



14. Make a backup. 
 
Make a backup of all company data and put it in safe permanent storage. The backup 
gives you a permanent record of the company's financial position at the beginning of the 
new year. This backup can be restored later if it is required. 

Frequently-asked questions 

1. Do I have to close the fiscal year before the first day of my next fiscal year? 
 
The year-end closing routine does not have to be completed before you start your next 
fiscal year. However, we recommend that you close the year as soon as possible. For 
additional information about how to print a Balance Sheet when you have two open years, 
click the following article number to view the article in the Microsoft Knowledge Base:  

866371 Printing a Balance Sheet for 2004 when 2003 is an open year using FRx  

2. 
Can I make adjusting entries after I close the year? 
 
You can post to the most recent historical year if the Posting to History check box is 
selected in the General Ledger Setup window. If you post an entry to a closed year, a 
second entry is automatically made that updates the beginning balances for the current 
fiscal year. 
 
The following tables show an adjusting entry and the way the entry appears in the posting 
journal. 
 
Adjusting entry  

12/25/2004 Administration Expenses $500  

 Cash  $500

Posting journal  

12/25/2004 Administration Expenses $500  

 Cash  $500

12/31/2004 Retained Earnings $500  

 Cash  $500

 

3. 
After I performed the year-end closing routine, beginning balances were brought forward 
for some of my sales and expense accounts. Some of my asset accounts also closed to the 
retained earnings account. Why did this problem occur, and what can I do to correct it? 
 
The posting type that is specified in the Account Maintenance window for the account 
determines whether a balance is brought forward for the account or whether the account 
is closed to the retained earnings account. Accounts that use the Balance Sheet posting 
type carry a balance forward. Accounts that use a Profit and Loss posting type close to 
the retained earnings account. To resolve this problem, restore from a backup, correct the 
posting type, and then run the year-end closing routine again. 
 



For additional information about how to correct accounts that have an incorrect posting 
type without restoring from backup, click the following article number to view the article in 
the Microsoft Knowledge Base:  
864913 Correcting accounts set up with the wrong posting type after year-end close  

4. I tried to run the year-end closing routine by using a divisional retained earnings account, 
but I received the following error message:  

Retained Earnings account not found. 

What can I do to resolve the problem that provokes this error message? 
 
The year-end closing routine must validate the existence of all the divisional retained 
earnings accounts that are required before the routine can continue. For example, 
Fabrikam, Inc., the Great Plains demonstration company, uses an account format of nnn-
nnnn-nn. The first segment represents the department. A retained earnings account must 
exist for each department that has a profit and loss account. For example, if sales account 
400-4100-00 exists, but no 400-nnnn-nn retained earnings account exists, you receive 
this error message. 
For additional information about how to close to divisional retained earnings accounts, 
click the following article numbers to view the articles in the Microsoft Knowledge Base:  

850615 How to use divisional retained earnings accounts in General Ledger  
850741 "Retained earnings account not found" error message in General Ledger year-
end closing process  

An Automated Solution script may be available to perform this task. For more information 
about error messages that are related to retained earnings accounts that cannot be found, 
visit the following Microsoft Business Solutions Web site:  
https://mbs.microsoft.com/customersource/support/AutomatedSolutions.htm 

5. What happens to unit accounts during the year-end closing routine? 
 
Unit accounts are treated as balance sheet accounts. Unit accounts have a balance that is 
brought forward when the year is closed. For additional information about how to clear the 
beginning balances for unit accounts, click the following article number to view the article 
in the Microsoft Knowledge Base:  

857582 Query to clear beginning balances for unit accounts  

6. I am getting ready to close my year in the General Ledger module. Must everyone quit 
Great Plains Dynamics before I perform the year-end routine? 
 
We recommend that client computer users stop work in Great Plains while the year-end 
closing routine is processing. If users continue to work in Great Plains, transactions may 
have to be entered again if problems occur during the year-end closing routine. 

7. 
I want to allocate my net profit to my retained earnings account or to my capital accounts 
on a monthly basis. Also, net profit is supposed to be allocated to three different retained 
earnings accounts or capital accounts. Can I do this? 
 
No, you cannot do this. However, you can specify a non-financial account in the Account 
Maintenance window. Use a number that is not in your current account numbering 
scheme. This account acts as a suspense account for the net income or the net loss. Every 
month, you can post an adjusting entry to the three capital accounts that you want to 
adjust. For the offset account, use the suspense account. When the year-end closing 
routine is finished, use the suspense account as the retained earnings account. This 
offsets all the manual adjustments that you made to the suspense account during the 
year. Make sure that the suspense account does not appear on reports. 
 
If you are using Advanced Financial Analysis for financial statements, when you format 
the Balance Sheet, put the NP line as the last line on the Advanced Financial Analysis 
statement. Then, put a page break before the NP line. The Balance Sheet must have an 



NP line, but this line makes the net income or the net loss appear two times. Therefore, 
format the NP line so that it is off the financial statement. You can also use a report type 
of Other. 

8. 
Why is the status of some of my financial reports set to Invalid? 
 
If a report is marked to use the accelerator file, any changes that are made to accounts in 
one of the following windows causes the status of financial report printing options to 
change to Invalid:  

• Account Maintenance 

• Unit Account Maintenance 

• Mass Modify Chart of Accounts 

• Year-End Closing 

Before you print financial statements, you must update the accelerator file. To do this, 
follow these steps:  

a.  Click Reports, click Financial, and then click Update Financial Accelerator. 

b.  Click Update, and then click Continue. 

c.  Close the Update Financial Accelerator Information window. 
 

9. 
How are non-financial accounts closed during the year-end closing routine? 
 
If the non-financial account is configured to use the Balance Sheet posting type, the 
account balance is brought forward during the year-end closing routine. If the non-
financial account is configured to use the Profit and Loss posting type, the account 
balance is closed to the retained earnings account during the year-end closing routine. 

10. When I try to post a batch in the General Ledger module, I receive the following message:  

Batches cannot be posted while the Year-End Close is in progress. 

The year-end closing routine is not being run in the General Ledger module. What should I 
do? 
 
To resolve this issue, have all users close any transaction entry windows. Then, make the 
following changes:  

• If you are using a Pervasive Software Pervasive.SQL database, rename the 
SY00800.btr file. 

• If you are running a FairCom c-tree database, rename the SY00800.dat file and the 
SY00800.idx file. 

• If you are running a Microsoft SQL Server database, delete the SY00800 file. To do 
this, use the following code:  

delete SY00800 where BACHNUMB = 'GL_Close' 

For additional information, click the following article number to view the article in the 
Microsoft Knowledge Base:  

856550 General Ledger year end close still in process and batches cannot be posted  

11. I receive the following message when I try to close the year in the General Ledger 
module:  

Sorry, another user is closing the year. 

No one else is trying to close the year. What should I do? 
 



To resolve this issue, make the following changes:  

• If you are using a Pervasive.SQL database, rename the GL50100.btr file. 

• If you are using a c-tree database, rename the GL50100.dat file and the 
GL50100.idx file. 

• If you are using a Microsoft SQL Server database, delete the SY00800 file. To do 
this, use the following code: 

delete SY00800 where BACHNUMB = 'GL_Close' 

If you must post the batches before you close the year, click Cancel. If you do not have 
to post the batches before you close the year, click Continue. 

12. I am performing the year-end closing routine in the General Ledger module and it appears 
to be stopped at 50 percent. My workstation seems like it has stopped responding. What 
should I do?  
 
If your year-to-date transaction open file (GL20000) is large, it may take a long time for 
the year-end closing routine to finish. If your hard disk is still processing, the year-end 
closing routine has not stopped responding. We recommend that you leave the routine to 
run. If your hard disk is not processing, we recommend that you restore from a backup. 
Then, follow the steps in this article again, starting at step 5. 

13. If an adjusting entry has been posted to a year that is closed, can I print a corrected Trial 
Balance Report for that year?  
 
Yes, you can print a corrected Trial Balance Report for the year that is closed. To do this, 
follow these steps:  

1. Click Reports, click Financial, click Trial Balance, and then click New. 

2. In the Option field, type With Adjustments. 

3. In the Include area, click to select the Posting Accounts check box. 

4. Click to select the History check box in the Year area, and then select the 
historical year from the Year list. 

5. Click Destination to specify a report destination, and then click OK. 

6. Click Print. 
 

14. How does Great Plains determine the financial statement that is printed for the account 
that I am adding? 
 
The category determines the type of financial statement that is printed when you use 
quick financial statements for the account that you are adding. The category is either the 
Balance Sheet category or the Profit and Loss category. You must format the reports to 
print the accounts that you want in Advanced Financial Analysis and in FRx Reporter. The 
posting type is used during the year-end closing routine to determine the accounts that 
close to the retained earnings account and to determine the account that carries a balance 
forward. The posting type does not affect the financial statements. 

 
 
The third-party products that this article discusses are manufactured by companies that are 
independent of Microsoft. Microsoft makes no warranty, implied or otherwise, regarding the 
performance or reliability of these products.  
 



Receivables Management Year-End Processing Guidelines 

Summary  
This article contains checklists and tips for performing the year-end closing in Microsoft Great Plains 
Receivables Management, versions 7.0, 7.5, and 8.0.  

More information 
See the notes in the following section if you are not going to post all transactions for the current 
year before you close the fiscal year, or if you plan to post into the new year before you close the 
current fiscal year.  

Notes  

• When you are posting transactions in Great Plains Receivables Management, version 7.0 or 
later versions, the system will automatically post to the correct fiscal and calendar years 
according to the dates of the transactions. To view these amounts in the Customer 
Summary window, follow these steps:  

1. Click Cards, point to Sales, and then click Summary.  

2. Click to select a customer, and then click to select either Fiscal Year or Calendar 
Year. 

3. Enter a year or a period, and then click Calculate. 
 

• The Customer Summary window lets you view amounts in the following three summary 
views:  

• Amounts Since Last Close 

• Fiscal Year 

• Calendar Year 

These three options are also available when you print the RM Sales Analysis report. To 
print this report, click Reports, point to Sales, click Analysis, and then click to select the 
Receivables Sales Analysis report.  

• You can view individual period amounts from the Customer Period Summary window. To 
open this window, click Cards, point to Sales, and then click Summary. Click to select a 
customer, and then click History. These amounts will appear in the correct periods 
according to their transaction dates. The RM Period Sales Analysis report will reflect the 
same information and can be printed in any one of the three views. To print this report, click 
Reports, point to Sales, click Analysis, and then click to select the Period Sales Analysis 
report.  

• The year-end closing process has not changed with the date-sensitive enhancement that was 
added in version 7.0. Closing the fiscal year will affect the Amounts Since Last Close view 
in the Customer Summary window. To open the Customer Summary window, click 
Cards, point to Sales, and then click Summary. The date-sensitive enhancement added 
options to view the data date-sensitively. 

Detailed Receivables Management calendar year-end closing checklist  
To close the calendar year, click Tools, point to Routines, point to Sales, and then click Year-End 
Close. This process will clear the calendar year-to-date finances charges and will move them to the 
Last Year Calendar field in the Customer Finance Charge Summary window. To open this 



window, click Cards, point to Sales, and then click Summary. You should perform the following 
procedure before you start posting transactions for a new fiscal year:  

1. Post all transactions for the current fiscal year before you close the year. 

2. Make a backup copy of your company data so that you will be able to recover quickly if a 
power fluctuation or other problem occurs during the year-end closing procedure. 

3. Close the calendar year.  

• In the Receivables Year-End Closing window, click to select the year that you want 
to close. To open this window, click Tools, point to Routines, point to Sales, and 
then click Year-End Close. If the calendar year coincides with your fiscal year, click 
to select All. If the calendar year does not coincide with your fiscal year, close the 
fiscal year and the calendar year separately.  

• Click to select the Print Report box. This report lists the amounts that were 
transferred to last-year fields for each customer. 

• The Year-End Closing report will print. It is part of the audit trail, and you should 
save it with your company's permanent records. 

 

4. Close the fiscal periods for the Sales series. (This step is optional.)  

• You can use the Fiscal Periods Setup window to close any fiscal periods that are still 
open for the year. To open this window, click Tools, point to Setup, point to 
Company, and then click Fiscal Periods. Closing the fiscal periods that are still open 
for the year prevents transactions from accidentally being posted to the wrong period 
or to the wrong year. 

• Make sure that you have posted all transactions for all modules for both the period 
and the year before you close fiscal periods. 

• If you later have to post transactions to a fiscal period that you have already closed, 
you will have to return to the Fiscal Periods Setup window to reopen the period 
before you can post the transaction. 

 

5. Close the sales tax periods for the year. (This step is optional.)  

• Use the Tax Year-End Closing window to close the sales tax periods and to print the 
Tax Year End Closing report. To open this window, click Tools, point to Routines, 
point to Company, and then click Tax Year-End Close. 

• Complete this procedure only after you have completed the year-end closing 
procedures for all Sales and Purchasing modules.  

 

6. Make a final backup copy of your company's data files and keep it in permanent storage. 
This gives you a permanent record of the company's financial position at the time that you 
closed the year. You can restore the backup copy later, if you have to.  

Detailed Receivables Management fiscal year-end closing checklist  

1. Post all transactions for the current fiscal year before you close the year.  

2. Make a backup copy of your company data so that you will be able to recover quickly if a 
power fluctuation or other problem occurs during the year-end closing procedure. 



3. Close the fiscal year.  

• In the Receivables Year-End Closing window, click to close the fiscal year. To open 
this window, click Tools, point to Routines, point to Sales, and then click Year-End 
Close, Mark Fiscal, or All. 

• Click to select the Print Report box. This report lists the amounts that were 
transferred to last-year fields for each customer. 

• The Year-End Closing report will print. It is part of the audit trail, and you should 
save it with your company's permanent records. 

 

4. Close the fiscal periods for the Sales series. (This step is optional.)  

• You can use the Fiscal Periods Setup window to close any fiscal periods that are still 
open for the year. To open this window, click Tools, point to Setup, point to 
Company, and then click Fiscal Periods. Closing the fiscal periods that are still open 
for the year prevents transactions from accidentally being posted to the wrong period 
or to the wrong year. 

• Make sure that you have posted all transactions for all modules for both the period 
and the year before you close fiscal periods. 

• If you later have to post transactions to a fiscal period that you have already closed, 
you will have to return to the Fiscal Periods Setup window to reopen the period 
before you can post the transaction. 

 

5. Close the sales tax periods for the year. (This step is optional.)  

• Use the Tax Year-End Closing window to close the sales tax periods and to print the 
Tax Year End Closing report. To open this window, click Tools, point to Routines, 
point to Company, and then click Tax Year-End Close. 

• Complete this procedure only after you have completed the year-end closing 
procedures for all Sales and Purchasing modules.  

 

6. Make a final backup copy of your company's data files and keep it in permanent storage. 
This gives you a permanent record of the company's financial position at the time that you 
closed the year. You can restore the backup copy later, if you have to.  

Receivables Management year-end closing tips  

1. The calendar and fiscal year-end closes must be performed on the appropriate date before 
any transactions are posted for the new year.  

2. Closing the calendar year will clear the calendar year-to-date finance charges and will move 
them to the Last Year field in the customer records.  

3. The calendar year-end close in Receivables will occur at the end of the calendar year, 
regardless of when your fiscal year ends. If your calendar year coincides with the fiscal 
year, you will close both of them at the end of the calendar year. 

4. The YTD finance charges do not automatically print on the statements in December and 
January. If you want them to print on the statements, you must modify them by using the 
following procedures. These procedures are different for each month.  



• December:  

a.  Create a modified version of the statement, and then link the Customer MSTR 
Summary file to the report. 

b. Put the CYTD Finance Charges field from the Customer MSTR Summary file 
into the report layout.  

c.  Save the report and print it. 
 

• January:  

a.  Create a modified version of the statement, and then link the Customer MSTR 
Summary file to the report. 

b. Put the LYTD field from the Customer MSTR Summary file into the report 
layout. 

c.  Save the report and print it. 
  

5. Closing the fiscal year will transfer all amounts other than the calendar year-to-date finance 
charge amounts to last year. 

 



Payables Year-End Processing Guidelines 

SUMMARY 
This article describes the year-end closing procedure for Payables Management. Each of the 
following topics are explained in detail in the following sections:  

• Payables Management Calendar Year-End Closing Checklist  

• Payables Management Fiscal Year-End Closing Checklist  

• Payables Management Year-End Closing Tips  

• Payables Management Year-End FAQ 

Note If you are on release 6.0, you must close the calendar year and fiscal year before you post 
transactions to the new year so that your reports and 1099s will be correct. Version 6.0 is not date 
sensitive. 

MORE INFORMATION 
1. Payables Management is date sensitive as of release 7.0. You can post a transaction to a prior or 
subsequent year and it will not affect your current year’s 1099 information or Vendor Financial 
Summary reports. The 1099 information now pulls from the PM Vendor Master Period Summary 
table (PM00202). 
 
When posting transactions, the system will automatically post to the correct fiscal and calendar 
years according to the dates of the transaction. Therefore, you do not have to run the Calendar Year 
End and Fiscal Year End on the last day of the calendar or fiscal year, unless you use SmartList or 
Vendor Summary reports.  
 
SmartList reports or Vendor Summary reports pull data from the Amounts Since Last Close view 
as it appears when you click Cards, click Purchasing, and then click Summary. The Amounts 
Since Last Close is the total of the amount since the calendar and fiscal year was last closed. To 
make sure that these reports display the correct amounts, you must close the calendar year and 
fiscal year before posting transactions to the new year. 
 
The Calendar Year Summary View and the Fiscal Year Summary View when you click Cards, 
click Purchasing, and then click Summary will display the correct amounts for the year selected 
regardless of whether the year has been closed or not. 
 
2. Closing the Payables Management Calendar year will transfer the 1099 Amount from the Year 
to Date column to the Last Year column in the Amounts Since Last Close view. When you print 
the 1099s, the information is pulled from period information so they will be correct. 
 
3. Closing the Payables Management fiscal year will transfer the Amount Billed and Amount Paid 
amounts from the Year to Date column to the Last Year column in the Amounts Since Last 
Close view. 
 
Note If you use SmartList or Vendor Summary reports, use the following steps to close the 
Payables Management calendar year.  

Payables Management Calendar Year-End Closing Checklist 
Summary 
 
1. Post all transactions for the calendar year.  
2. Make a backup.  



3. Verify 1099 information is correct. 
4. Print 1099 statements using the Print 1099 window.  
5. Make a backup.  
6. Close the calendar year using the Payables Year-End Closing window.  
7. Close the sales tax periods for the year using the Tax Year-End Closing window (optional).  
8. Make a final backup.  
 
Detail  
 
1. Post all transactions for the calendar year BEFORE you close the year. If you want to enter 
future-period transactions before you close the year, create a batch with new transactions. Save the 
batch but do not post the new batch until after the year has been closed. 
 
Print the Aged Trial Balance with Options Report (click Reports, click Purchasing, click Trial 
Balance, and then click Aged Trial Balance w/Options) to show the status of each Vendor 
Account. This report should be kept with your permanent records as part of the audit trail. 
 
If you are closing the fiscal year together with the calendar year, we recommend that you print the 
Vendor Period Analysis Report (click Reports, click Purchasing, click Analysis, and then click 
Period) and the Vendor Year-to-Date Summary reports (click Reports, click Purchasing, click 
Analysis, and then click Calendar Year) for your permanent records because these amounts will 
be transferred to last year during the year-end closing process. 
 
2. Make a backup of all Company data and put it in a permanent storage. This gives you a 
permanent record of the Company’s financial position at the end of the year and can be restored 
later. 
 
3. Verify the 1099 information is correct by printing the 1099 Edit List.  

• For release 7.x, click Routines, click Purchasing, and then click Print 1099. 

• For release 8.0, click Tools, click Routines, click Purchasing, and then click Print 1099. 

To print the edit list from the Print 1099 window, click Print on the File menu. You can also print 
the 1099 Edit List if you click the printer icon from the Print 1099 window. 
 
The 1099 Amount information is updated automatically when a 1099 invoice is fully paid. The 1099 
information can be edited for each vendor using the Vendor Period Summary window (click 
Cards, click Purchasing, click Summary, and then click Period). 
 
4. Print 1099 statements using the Print 1099 window. This step can be completed at any time. 
You will be able to select the year you want to print the 1099s for. 
 
5. Make a backup of all Company data and put it in permanent storage. This gives you a permanent 
record of the Company’s financial position at the end of the year and can be restored later if you 
need it. 
 
6. Close the calendar year using the Payables Year-End Closing window. Select whether you 
want to close the fiscal year, calendar year, or All to close both years. If the calendar year coincides 
with your fiscal year, select All. If they do not coincide, close the fiscal year separately.  
 
Mark the Print Report option to print the Payables Year-End Closing report after the closing 
process is completed. This report lists the amounts transferred to Last Year Summary amounts for 
each vendor. The report will print the amounts from the date of the current close to the prior year 
close. The amounts may be different from what appears when you click Cards, click Purchasing, 
click Summary, and then click Yearly. 
 
The Year-End Closing Report is part of the audit trail and should be saved with your Company’s 
permanent records. 
 
To close the year:  



• In Release 7.x, click Routines, click Purchasing, and then click Year-End Close. 

• In Release 8.0, click Tools, clickRoutines, click Purchasing, and then click Year-End 
Close.  

7. Close the sales tax periods and print the Tax Year-End Closing Report for the year using the Tax 
Year-End Closing window. This step is optional.  
Note This procedure should only be completed after you have completed the year-end closing 
procedures for all sales and purchasing modules.  

• In Release 7.x, click Routines, click Purchasing, and then click Tax Year-End Close.  

• In Release 8.0, click Tools, clickRoutines, click Purchasing, and then click Tax Year-End 
Close. 

 
 
8. Make a final backup of all Company data and put it in permanent storage. 

Payables Management Fiscal Year-End Closing Checklist  
Summary 
 
1. Post all transactions for the current fiscal year.  
2. Make a backup.  
3. Close the fiscal year in the Payables Year-End Closing window.  
4. Close all fiscal periods (optional).  
5. Close the sales tax periods for the year using the Tax Year-End Closing window (optional).  
6. Make a final backup.  
 
Detail 
 
1. Post all transactions for the calendar year BEFORE you close the year. If you want to enter 
future-period transactions before you close the year, create a batch with new transactions. Save the 
batch but do not post the new batch until after the year has been closed. 
 
Print the Aged Trial Balance with Options Report to show the status of each Vendor Account. This 
report should be kept with your permanent records as part of the audit trail. 
 
If you are closing the fiscal year together with the calendar year, we recommend that you print the 
Vendor Period Analysis Report and the Vendor Year-to-Date Summary reports for your permanent 
records because these amounts will be transferred to last year during the year-end close process.  
 
2. Make a backup of all Company data and put it in permanent storage. This gives you a permanent 
record of the Company’s financial position at the end of the year and can be restored later if you 
need it. 
 
3. Close the fiscal year using the Payables Year-End Closing window. Select whether you want to 
close the fiscal year, the calendar year or All to close both years. If the calendar year coincides with 
your fiscal year, select All. If they do not coincide, close the fiscal year separately.  
 
Mark the Print Report option to print the Payables Year-End Closing Report after the closing 
process is completed. This report lists the amounts that were transferred to Last Year Summary 
amounts for each Vendor. The Year-End Closing Report is part of the audit trail and should be saved 
with your Company’s permanent records. 
 
To close the year:  



• In Release 7.x, click Routines, click Purchasing, and then click Year-End Close. 

• In Release 8.0, click Tools, clickRoutines, click Purchasing, and then click Year-End 
Close.  

4. Close all fiscal periods (optional). You can use the Fiscal Periods Setup window to close any 
fiscal periods that are still open for the year. This keeps transactions from accidentally being posted 
to the wrong period or year. Make sure you have posted all transactions for the period and year for 
all modules before you close fiscal periods. 
 
If you must post transactions to a fiscal period you have already closed, you must return to the 
Fiscal Periods Setup window to reopen the period before you can post the transactions. 
 
5. Close the sales tax periods for the year using the Tax Year-End Closing window (optional). Use 
this window to close the sales tax periods and to print the Tax Year End Closing report. This 
procedure should only be performed after you have completed the year-end closing procedures for 
all Sales and Purchasing modules. 
 
6. Make a final backup of all Company data and put it in permanent storage. 

Payables Management Year-End Closing Tips 
1. Print the 1099 statements using the Print 1099 window. The following list provides information 
included in each box on the 1099 statements and the lines and windows in Great Plains Payables 
Management where the information comes from.  

• PAYERS name, street address, city, state and ZIP Code/Postal Code 
Taken from the Company and Address fields in the Print 1099 window.  

• PAYERS Federal Identification number  
Taken from the Payers Federal ID Number field in the Print 1099 window  

• RECIPIENTS name, address and ZIP Code/Postal Code  
Taken from the Primary Address fields in the Vendor Maintenance window  

• RECIPIENTS identification number  
Taken from the Tax ID field in the Vendor Maintenance Options window  

• Account number  
This field is optional. You can manually enter the Account number.  

• Boxes 1 through 9 (Dividend Form), and 1 through 16 (Misc. Form) 
Taken from the 1099 Amount field in the Vendor Yearly Summary window.  

The 1099 Amount YTD information is updated automatically when a 1099 Invoice is paid. The 1099 
YTD information can be edited for each Vendor using the Vendor Period Summary window (click 
Cards, click Purchasing, click Summary, and then click Period). This would be needed if a 1099 
invoice was entered, but a 1099 amount was not entered.  
 
Currently, Great Plains does not handle magnetic media filing of state 1099s. The following 
Microsoft Great Plains Partner does offer compatible State W-2 and 1099 magnetic media products. 
For more information, contact:  
 
Greenshades Accounting Software, Inc.  
7800 Belfort Parkway 



Suite 220  
Jacksonville, FL 32207  
General: 1-800-209-9793 (Toll-Free)  
Sales: 1-800-209-9793x2 (Toll-Free)  
sales@greenshades.com  
http://www.greenshades.com  

Payables Management Year-End FAQ  

Q: Are inactive Vendor records cleared during year-end closing? If not, how can inactive Vendor 
records be removed?  
 
A: No, inactive Vendor records are not automatically removed. To remove an inactive Vendor 
record, the record must not have a current year 1099 amount or documents in history (the work 
and open files have to be empty for this Vendor to be inactive). When the records have been 
removed from history, a Vendor or Vendors can be deleted using the Vendor Maintenance window 
or the Mass Vendor Delete window. 
 
Q: What exactly do the Payables Management Year-End Close procedures do?  
 
A: The Calendar Year-End Close moves the 1099 Amount YTD into 1099 Last Year in the Vendor 
Yearly Summary Amounts Since Last Close view. The Fiscal Year-End Close moves all other YTD 
amounts into Last Year amounts.  
 
Q: What should I do if I must issue a check on January 2, 2005, but am not ready to close 2004 
yet? 
 
A: Run the calendar and fiscal year-end close for Payables. If you use SmartList or the Vendor 
Summary report, you can manually update the Amounts Since Last Close view for any additional 
2004 activity entered after the close. The 1099 information will be correct. 
 
Q: Is there a way to print an edit list of the 1099 Vendors before I actually print the 1099 
statements?  
 
A: A 1099 report can be printed using the Print 1099 window. When the Print 1099 window is 
open, click Print on the File menu. An edit list that contains the Vendor ID, Vendor Name, Address, 
and 1099 amount will be printed. You can also print the edit list if you click the printer icon in the 
Print 1099 window.  
 
Q: I have printed 1099 statements and some the statements did not have the Vendor Name 
appearing on them. What should I do? 
 
A: When you print 1099 statements, the Check Name entered for the Vendor record in the Vendor 
Maintenance window will appear on the statement. If there is no Vendor Name appearing on the 
statement, the Check Name field in this window is blank. Enter a Check Name for each Vendor or 
use Report Writer to change the report to use a different field. For more information about 
modifying a report, see the Report Writer manual. 
 
Note If you are on release 6.0, you must close the calendar year and fiscal year before you post 
transactions to the new year so that your reports and 1099s will be correct. Version 6.0 is not date 
sensitive. 



Payroll Year-End Processing Guidelines 

SUMMARY 
This document outlines the recommended year-end closing procedures for Microsoft Dynamics GP 
Payroll. The "More Information" section contains the following:  

• A detailed checklist of the steps that you must follow to complete the year-end closing 
procedures. 

• An alternative checklist to use instead of the standard checklist if you must process 2006 
pay runs before you complete the year-end closing procedures. 

INTRODUCTION 
Read all of this article before you perform any one of the steps. If you have any questions, contact 
Microsoft Business Solutions Technical Support.  

MORE INFORMATION 

Payroll year-end checklist 
To perform the year-end closing procedures, follow these steps:  

1. Verify the version of Microsoft Dynamics GP 

2. Complete all pay runs for the current year 

3. Complete all monthly and quarterly payroll period-end procedures for the current year 

4. Make a backup of the original file 

5. Install the Year-End Update 

6. Create the Year-End file 

7. Make a backup of the new file 

8. Verify W-2 and 1099-R statement information 

9. Print the W-2 statements and the W-3 Transmittal form 

10. Print the 1099-R forms and the 1096 Transmittal form 

11. Optional: Create a magnetic media file 

12. Optional: Archive inactive employee Human Resources information 



13. Set up fiscal periods for 2006 

14. Optional: Close fiscal periods for the payroll series for 2005 

15. Install the payroll tax update for 2006 

Alternative payroll year-end checklist 
If you must process 2006 pay runs before you complete the year-end closing procedures, follow the 
steps in this alternative checklist:  

1. Verify the version of Microsoft Dynamics GP 

2. Complete all pay runs for the current year 

3. Optional: Complete all monthly and quarterly payroll period-end procedures for the 
current year 

4. Make a backup of the original file 

5. Install the Year-End Update 

6. Create the year-end file 

7. Make a backup of the new file 

8. Verify W-2 and 1099-R statement information 

9. Optional: Archive inactive employee Human Resources information 

10. Set up Fiscal Periods for 2006 

11. Optional: Close the fiscal periods for the Payroll series for 2005 

12. Install the payroll tax update for 2006 

13. Process the 2006 pay runs. The user date must occur in 2006. 

14. Print the W-2 statements and the W-3 Transmittal form 

15. Print the 1099-R forms and the 1096 Transmittal form 



16. Optional: Create a magnetic media file 

Payroll module year-end details 

Verify the version of Microsoft Dynamics GP 

The 2005 Payroll Year-End Update file and the 2006 Payroll Tax Update file are available for 
Microsoft Business Solutions - Great Plains 7.5, for Microsoft Business Solutions - Great Plains 8.0, 
and for Microsoft Dynamics GP 9.0. The 2005 Payroll Year-End Update file and the 2006 Payroll Tax 
Update file are not compatible with versions of Microsoft - Great Plains that are earlier than version 
7.5. 
 
Before you complete the steps in this article, you should install the latest service packs for Microsoft 
Great Plains according to the following table. To view the version information, click Help, and then 
click About Microsoft Business Solutions - Great Plains.  

Microsoft Great Plains version Service pack Dexterity runtime

7.50g66 Service Pack 7 7.50m019 

8.00g44 Service Pack 3 8.00m079 

For more information, visit one of the following Microsoft Web sites, depending on whether you are 
a partner or a customer:  
Partners 
https://mbs.microsoft.com/partnersource/products/GreatPlains/downloads/servicepack 
 
Customers 
https://mbs.microsoft.com/customersource/support/downloads/servicepacks 

Complete all pay runs for the current year 

(Optional): Complete all monthly and quarterly payroll period-end procedures for the 
current year 

For more information about period-end procedures for payroll, view Chapter 21, "Payroll Company 
Routines," in the Microsoft Dynamics GP user's manual.  

Make a backup of the original file 

Create a backup, and then put this backup into safe, permanent storage. By creating a backup, you 
make sure that you have a permanent record of the company's financial position at the end of the 
year. You can restore the backup to quickly recover data if a power fluctuation or other problem 
occurs during the year-end closing procedure. 
 
To create a backup in Microsoft Great Plains or in Microsoft Dynamics GP, follow these steps:  

1. On the File menu, click Backup. The Back Up Company dialog box opens. 

2. In the Company Name list, click your company name. 

3. 
Change the path of the backup file if it is required, and then click OK. 
 
Note We recommend that you name this backup 2005 Pre Year-End Tax Update to 
differentiate it from your other backups. 

Install the year-end update 

To install the payroll year-end update, you must follow these steps on each computer that has 
Microsoft Great Plains or Microsoft Dynamics GP installed:  



Microsoft Great Plains 7.5 

Install the update from one of the following locations, depending on whether you are a partner or a 
customer:  
Partners 
https://mbs.microsoft.com/partnersource/downloads/taxupdates/ 
Customers 
https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 

Microsoft Great Plains 8.0 and Microsoft Dynamics GP 9.0 

1. On the Help menu, point to Products and Services, and then click Check for Year-End 
Updates. 

2. In the Payroll Year-End Update dialog box, click Automatic, and then click Next. 

3. In the Authorization Number field of the Log on to Customer Source for Year-End 
Update dialog box, enter your authorization number. 

4. In the Payroll Year-End Update dialog box, click Finish. 

Create the year-end file 

To create the year-end file, follow these steps:  

1. On the Tools menu, point to Routines, point to Payroll, and then click Year-End 
Closing. 

2. 
In the Year field, type 2005, and then click Process. 

Note You can install the payroll tax update for 2006 any time after the year-end file for 2005 has 
been created.  

Make a backup of the new file 

Create a backup, and then put this backup into safe, permanent storage. By creating a backup, you 
make sure that you have a permanent record of the company's financial position at the end of the 
year. You can restore the backup to quickly recover data if a power fluctuation or other problem 
occurs during the year-end closing procedure. 
 
To create a backup in Microsoft Great Plains or in Microsoft Dynamics GP, follow these steps:  

1. On the File menu, click Backup. The Back Up Company dialog box opens. 

2. In the Company Name list, click your company name. 

3. 
Change the path of the backup file if it is required, and then click OK. 
Note We recommend that you name this backup Post Year-End File to differentiate it 
from your other backups. 

Verify W-2 and 1099-R statement information 

To view the W-2 information, click Tools, point to Routines, point to Payroll, and then click Edit 
W-2s. 
 
To view the 1099-R information, click Tools, point to Routines, point to Payroll, and then click 
Edit 1099-Rs. 
 



Note If you change the W-2 or the 1099-R information, we recommend that you make another 
backup.  

Print the W-2 statements and the W-3 Transmittal form  

To print the W-2 statements, follow these steps:  

1. On the Tools menu, point to Routines, point to Payroll, and then click Print W-2s. 

2. In the Print W-2 Forms dialog box, specify the following settings:  

• Print W-2s for: Normal Year-End 

• Print: W-2 Forms 
 

3. Click Print. 

Note You can print employee W-2 statements as many times as you have to. 
 
To print the W-3 Transmittal Form, follow these steps:  

1. On the Tools menu, point to Routines, point to Payroll, and then click Print W-3s. 

2. In the Print W-2 Forms dialog box, specify the following settings:  

• Print W-2s for: Normal Year-End 

• Print: W-3 Transmittal Form 
 

3. Click Print. 

Note You can print the W-3 Transmittal Form as many times as you have to.  

Print the 1099-R forms and the 1096 Transmittal form 

To print the 1099 forms, follow these steps:  

1. On the Tools menu, point to Routines, point to Payroll, and then click Print 1099Rs. 

2. In the Print 1099-R Forms dialog box, click 1099-R Forms, and then click Print. 

Note You can print employee 1099-R forms as many times as you have to. 
 
To print the 1096 Transmittal form, follow these steps:  

1. On the Tools menu, point to Routines, point to Payroll, and then click Print 1099Rs. 

2. In the Print 1099-R Forms dialog box, click 1096 Transmittal Form, and then click 
Print. 

Note You can print the 1096 Transmittal form as many times as you have to.  

(Optional): Create a magnetic media file 

To create a magnetic media file, follow these steps:  

1. On the Tools menu, point to Routines, point to Payroll, and then click W-2 Magnetic 
Media. 



2. In the Magnetic Media dialog box, click to select the check box that is next to each 
company that you want to include in your magnetic media file. 

3. In the PIN field, enter the PIN. 

4. Click Submitter. The Magnetic Media Submitter Information dialog box opens. 

5. Enter the authorized submission information. 

6. Close the Magnetic Media Submitter Information dialog box. 

7. Change the file destination information in the File Name field if it is required. 

8. Click Create File. 

(Optional): Archive inactive employee Human Resources information 

To archive inactive employee Human Resources information, click Tools, point to Utilities, point to 
Human Resources, and then click Archive Employee.  

Set up fiscal periods for 2006 

To set up fiscal periods for 2006, follow these steps:  

1. On the Tools menu, point to Setup, point to Company, and then click Fiscal Periods. 

2. 
In the Year field, type 2006, and then click Calculate. 
Note You may want to close all periods except period 1 to prevent users from posting to 
future periods. 

3. Click OK. 

(Optional): Close fiscal periods for the payroll series for 2005 

You can use the Fiscal Periods Setup dialog box to close any fiscal periods that are still open for 
the year. By closing fiscal periods, you prevent users from accidentally posting transactions to the 
wrong period or to the wrong year.  
 
Before you close a fiscal period, verify that you have posted all transactions for the period and for 
the year for all modules. To later post a transaction to a fiscal period that you have closed, you 
must first reopen the period in the Fiscal Periods Setup dialog box. 
 
To close a fiscal period, follow these steps:  

1. On the Tools menu, point to Setup, point to Company, and then click Fiscal Periods. 

2. Click to select the Payroll check box for each Period that you close. 

Install the payroll tax update for 2006 

Note Do not install the payroll tax update for 2006 until the year-end file has been created for 
2005.  

Microsoft Great Plains 7.5 



Install the update from one of the following locations, depending on whether you are a partner or a 
customer:  
Partners 
https://mbs.microsoft.com/partnersource/downloads/taxupdates/ 
Customers 
https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 

Microsoft Great Plains 8.0 and Microsoft Dynamics GP 9.0 

To install the payroll tax update for 2006, follow these steps:  

1. On the Help menu, point to Products and Services, and then click Check for Payroll 
Tax Updates. 

2. In the Tax Update Method dialog box, click Automatic, and then click Next. 

3. In the Authorization Number field, type your authorization number, and then click Log 
in. 

4. Click Finish. 

Note You may also install this update from one of the following alternative locations, depending on 
whether you are a partner or a customer:  
Partners 
https://mbs.microsoft.com/partnersource/downloads/taxupdates/ 
Customers 
https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 

 



Fixed Assets Year-End Processing Guidelines 

Issue  
 
What are the recommended steps to close a year in Fixed Assets?  
 
Resolution  
 
Because Fixed Assets is not a date sensitive module, we recommend closing Payables 
Management first. This should be performed to ensure all transactions coming from 
Payables have been capitalized in the Fixed Assets system. Also, we suggest closing Fixed 
Assets prior to performing the General Ledger year-end close. The year-end routine can 
be run at a separate time for each fixed asset book or it can be run for all books at the 
same time. However, this routine must be completed before running any fixed assets 
processing for the new year.  
 
Functions Performed During the Year End Routine: 
 
1. In the Asset General Information window:  
 
-The YTD Maintenance amount is removed  
-The Quantity is copied to the Begin Quantity field  
 
2. In the Asset Book window:  
 
-The YTD Depreciation Amount is removed  
-The following fields are copied:  
Cost Basis to Begin Year Cost  
Life to Date Depreciation to Begin Reserve  
Salvage to Begin Salvage  
 
3. Increases the current fiscal year by one year for each book that is being closed.  
 
Year End Checklist: 
 
1. Complete Payables year-end. This will ensure all transactions are capitalized in Fixed 
Assets.  
 
2. Enter in all activity for the current fiscal year. This includes additions, changes, 
transfers and retirements. Note: Transfers and Undo Retirements should never be 
performed in a historical year.  
 
3. Run depreciation on all assets through the last day of the current fiscal year.  
 
4. Process the GL Interface (GL Posting) routine.  
Version 8.0: Tools | Routines | Fixed Assets | GL Posting 
Version 7.0 and higher: Routines | Fixed Assets | GL Posting  
Versions 6.0 and prior: Routines | Fixed Assets | GL Interface  
 
5. Run reports, specifically reports which include year-to-date depreciation amounts as 
that information is not saved for previous/closed fiscal years in Fixed Assets. Some 
suggested reports that are normally run at year-end are:  
 
-Annual Activity  
-Additions  



-Retirements  
-Transfers  
-Depreciation Ledger  
-Property Ledger  
-Fixed Assets to General Ledger Reconciliation  
 
The Book to Book Reconciliation and Book to Book YTD Depreciation Comparison reports 
are also available for comparing any two fixed assets books. There are over 25 standard 
reports that may be run. You may elect to print these reports to a file as well so you can 
choose to print them again in the future, if needed.  
 
6. Ensure the Fixed Assets Calendar is built correctly.  
 
Step 6 is for version 6.0 and prior. Please see KB Article 874133 if you are on version 7.0 
and higher and wish to rebuild your calendar. It is not necessary to create first and last 
"dummy" years that contain 365 days (366 days for a leap year) in version 7.0 and 
higher.  
 
If the last fiscal year created in the Dynamics/eEnterprise Fiscal Periods Setup 
encompasses an entire year (365 days or 366 days if a leap year), then you should 
rebuild and replace your calendar at this point. This can be performed at the following 
location:  
 
Version 8.0: Tools | Utilities | Fixed Assets | Build Calendar 
Version 7.0 and higher: Utilities | Fixed Assets | Build Calendar  
Version 6.0: Utilities | Financial Fixed Assets Build Calendar  
 
If the last year set up is missing any days (less than 365 days or 366 days if leap year) 
or overlapping any days (more than 365 days or 366 day if leap year), then a dummy 
year must be set up. Example below:  
 
Current Fiscal Period Setup  
2001 January 1, 2001 – December 31, 2001  
2002 January 1, 2002 – December 26, 2002  
2003 December 27, 2001 - December 29, 2003 (current fiscal year)  
* 2004 December 30, 2004 – December 27, 2004  
 
In this scenario, the 2004 fiscal year is only 363 days. Therefore, a dummy 2005 year 
needs to be set up in the Fiscal Periods Setup that contains 365 days (December 28, 
2004 – December 27, 2005). Once this year has been created, the Fixed Assets Calendar 
needs to be rebuilt and replaced. This can be performed at the following location:  
 
Version 8.0: Tools | Utilities | Fixed Assets | Buils Calendar 
Version 7.x: Utilities | Fixed Assets | Build Calendar  
 
7. Verify that the Quarters are set up correctly for all fiscal years.  
 
Version 8.0: Tools | Setup | Fixed Assets | Quarters 
Version 7.x: Setup | Fixed Assets | Quarters  
 
8. Make a permanent backup of all the fixed assets files to ensure that you can run 
additional reports later, if necessary. This should be a backup that is archived off-site and 
is never erased.  
 
9. Perform the Fixed Asset Year-End Close routine.  
 



Performing Year End Close:  
Version 8.0: Tools | Routines | Fixed Assets | Year End 
Version 7.x: Routines | Fixed Assets | Year End  
 
A. Verify that the Current Fiscal Year on the Available Books list is correct.  
 
B. Select each book to be closed by highlighting the book in the Available Books list and 
clicking Insert. The year-end process will be performed for each book in the Selected 
Books list.  
 
C. Click the Continue Button. The year-end process will begin. A report is not generated 
from this process.  
 
D. Verify that year-end completed successfully by using reports and inquiries to verify the 
items in the Functions Performed during Year End Routine section of this document.  
 
Fixed Assets Year-End FAQ:  
 
1. I have closed the General Ledger module and realized that I haven’t closed the Fixed 
Assets module yet. Can I perform the Fixed Assets Year-End close process at this point?  
 
We recommend closing the General Ledger module last (after all of the subsidiary 
modules have been closed.) However, Fixed Assets can be closed after the General 
Ledger Year-End Close. The GL Interface process can be performed and the 
transaction(s) posted to the closed/historical year in the General Ledger. To post to the 
historical year in General Ledger, make sure that the following options are marked in the 
General Ledger Setup window under Setup | Financial | General Ledger (Version 8.0, 
Tools | Setup | Financial | General Ledger):  
 
-Allow Posting to History  
-Maintain History Accounts  
-Maintain History Transactions  
 
The posted transaction will update the historical year and roll forward as a beginning 
balance to the open year. If any expense or revenue accounts were included in the 
transaction, they will automatically close out to the Retained Earnings account(s).  
 
2. I processed the Fixed Assets Year-End routine and have run depreciation in the new 
year. I noticed that the depreciation is highly overstated and some of my assets have a 
negative Net Book Value. Why is the system calculating so much depreciation?  
 
This will happen if the year was closed and the assets were not depreciated through the 
very last day of the fiscal year. For example, if the fiscal year is a calendar year (January 
1 – December 31) and the assets were depreciated through December 28th when the 
year was closed, depreciation will be incorrect the next time it is run. The system does 
not recalculate the yearly rate when the year-end routine is performed; therefore, it will 
take a full year’s worth of depreciation (the yearly rate currently on each asset) in the 
last few days remaining in the previous year (December 29th – December 31st). If there 
are assets near the end of their original life, it can cause the Net Book Value to go 
negative as well.  
 
There are a couple of solutions available if this situation is encountered. The first 
(recommended) solution would be to restore the data from a backup, run depreciation 
through the very last day of the year, and perform the year-end procedure. The other 
solution would be to reset life on all of the assets. However, if amounts have ever been 
plugged for YTD and LTD Depreciation on the assets, resetting the life would change 



those amounts and the end result may be different. This will cause inconsistencies 
between the Fixed Asset module and the General Ledger which would need to be 
accounted for.  
 
3. Instead of going through the year-end routine for Fixed Assets, I manually changed 
the Current Fiscal Year field in the Book Setup window to the next year. Do I need to go 
back and run the year-end routine or can I continue processing activity in Fixed Assets 
for the new year?  
 
If no activity (additions, changes, transfers, retirements, and/or depreciation) has been 
run for the new year, the Current Fiscal Year field in the Book Setup window can be 
changed back to the previous year and the year-end routine can be processed.  
 
If activity (additions, changes, transfers, retirements, and/or depreciation) has been run 
for the new year, restore the data from a backup and proceed with the year-end close 
routine.  
 
In either situation, the year-end routine needs to be run. If it isn’t, then the YTD 
Depreciation Amount will be overstated on any report that includes assets that were 
retired or fully depreciated in the previous year. When the year-end close is not 
performed, the YTD Depreciation amounts will not be removed (zeroed out) so they will 
be incorrectly included on the reports for the new year. 


	General Ledger
	Accounts Receivable
	Accounts Payable
	Payroll
	Fixed Assets

